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Basic Steps for Creating a Face   
 
To create a face, it is recommended you start with the shape of the chin, followed by the head. Once 
your face is completed, you might have to modify the chin to blend it in with the other features. 
Accessories such as mustaches, beards and glasses are usually added at the end. 
 
The most striking features of any face are the eyes and eyebrows. They must be added separately in 
order to ensure the eyes are not gender-specific and to allow for more than 20,000 eye/eyebrow 
combinations. 
 
The eyes are the only feature in the Viewer Area that remain vertically fixed, since they serve as a 
reference point from which the rest of the face is constructed. However, you can move them further 
apart or closer together. The eyebrows and eye lines automatically align themselves with the position of 
the eyes. 
 
Feature categories (e.g., eyes, eyebrows, nose, etc.) are divided into a corresponding set of sub-
categories (e.g. eyes are divided into narrow eyes, bulging eyes, almond-shaped eyes, etc.).  These 
feature sub-categories are arranged in morphological order (i.e. from the smallest to the largest), 
allowing you to create a face more quickly. 
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User Interface   
 
The FACES User Interface is the set of buttons, menus and windows used to create and modify 
composite pictures. 
 
This section describes some features of the interface which can help you use your FACES software more 
effectively. Details on how to use the Viewer Area, Features Palette and Selection Area are particularly 
helpful. 
 

 
 
1. Menu Bar 
2. Top Toolbar Area 
3. Folder Area (To Be Displayed Later) 
4. Viewer Area 
5. Features Area 
6. Selection Area 
7. Control Area 
8. BAC (Biometric Alphanumeric Code) Area 
9. Slide Show Area (To Be Displayed Later) 
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1. Menu Bar   
 
The Menu Bar is the horizontal bar located in the upper portion of your screen that contains all of the 
FACES commands (File, Edit, etc.) 
 

 
 
The Menu Bar commands are described in detail later in this guide. 
 

2. Top Toolbar   
 
The Top Toolbar is located at the top of the FACES window and consists of a series of buttons with 
icons which can be clicked to execute a number of FACES commands. 
 

 
 

New 
 

 
  
Use this command to create a new composite picture in FACES. 
 
If you select this command while you are working on a composite picture, a dialog box will appear 
asking if you wish to save your current work as a project. If you answer “Yes”, the Save As dialog box 
will appear, asking you to give a file name and location. If you answer “No”, the facial features will 
disappear from your screen, leaving you with a blank template.  

Open 
 

 
  
Use this command to open an existing composite picture in FACES. 
 
If you select this command while you are working on a composite picture, a dialog box will appear 
asking if you wish to save your current work as a project.  If you answer “Yes”, the Save As dialog box 
will appear asking you to give a file name and location. If you answer “No”, the Open dialog box will 
appear.  
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Save 
 

 
  
Use this command to save an open document to its current file name and directory. 
 
When you save a picture for the first time, FACES displays the Save As dialog box which allows you to 
enter a name for your picture. Once you have saved a composite picture to a specified file name and 
directory, you can use the Save command to save your document to the same name and directory. 
 
If you wish to change the name and directory of an existing picture before saving it, use the Save As 
command. 

Print Portrait  
 

 
  
Use this command to print a composite picture. The Print dialog box will appear in which you may 
specify the number of copies you wish to print, the destination printer and other printer setup options. 

Random Faces 
 

 
  
This command displays a composite picture that is generated through a random selection of facial 
features. Not only does it give inexperienced users an idea of how a face is created, it also familiarizes 
them with different types of facial features and characteristics. 

Start Autorun Demo 
 

 
  
Use this command to launch a FACES demonstration. 
 
The Autorun Demo is a default sequence of composite pictures that change approximately every second. 
You can modify the default sequence to create your own personalized sequence by selecting the Edit 
Autorun Demo command. 

Start Exercise / Stop Exercise 
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Use this command to start or stop the Observation Exercise. 
 
The Observation Exercise allows you to develop your observation skills. A composite picture generated 
by FACES is displayed for a few seconds. During this time, you should examine the picture closely and 
try to remember as many of the facial characteristics as possible in order to reproduce them afterwards. 
 
Before the exercise begins, a dialog box is displayed in which you can select a level of difficulty. These 
levels are determined either by the number of feature sub-categories available in each feature category, 
or by the duration of the display period. For example, the beginners’ level (Level 1) offers fewer 
available features to make your choices easier, as well as a longer display period. Once you have 
selected a level, the exercise begins. You can stop the exercise by re-selecting the Start Exercise / Stop 
Exercise command. 

Review Exercise Portrait 
 

 
  
This command displays the exercise portrait in the Selection Display window. 
 
The exercise portrait disappears from the Viewer Area after the specified time period, giving you time to 
reproduce it as accurately as possible. Once you are satisfied with your reproduction, you can re-display 
the exercise portrait by selecting the Review Game Portrait command. The exercise portrait will be 
displayed in the Selection Display, allowing you to compare your reproduction with the original. As 
soon as you click on any feature button in the Features Palette, the exercise portrait disappears and the 
feature image boxes reappear in the Selection Display. 

Help 
 

 
  
Use this command to display the opening screen of Help, which provides detailed instructions on how to 
use FACES as well as a variety of reference information. 
 
Once the Help file is open, you can click the Contents button each time you want to return to the 
opening screen. 
 

3. Folder Area  
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The Folder Area displays thumbnails of all FACES files belonging to a particular folder. When you 
double click on one of these thumbnails, the corresponding composite picture will be displayed in the 
Viewer Area. 
 

 

Scan Folder  
 

 
 
You can use the Scan Folder command to open a dialog box that will allow you to select a folder. Once 
you have selected a folder, a scan is performed to find all the FACES files in it. The thumbnails of these 
files are then displayed in the Folder Area. 
 

4. Viewer Area   
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The Viewer Area is the portion of the viewer window in which your composite picture is displayed.  It 
functions purely as a display window. Double clicking on a particular element will display the desired 
category on the Selection Area. 

File Name Area 
 

 
 
The File Name Area is located right above the viewer. It displays the file name corresponding to the 
composite picture currently displayed in the Portrait Area. If the current portrait is a new file that hasn’t 
yet been assigned a file name, the file name is indicated as “untitled”. 

Hide/Show Portrait  
 

 
      
The button for the Hide/Show Portrait command is located directly above the Portrait Area and allows 
you to keep your work confidential. When the button is clicked, it will hide the composite picture you 
are working on, displaying only the Portrait Area background. This option is useful if you have to leave 
your desk temporarily while working on a composite picture that is confidential. 

Full Screen 
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When the Full Screen button is clicked, the composite picture is displayed alone on a white background. 
You can revert to normal screen mode by clicking again on the Full Screen button. All of the buttons 
and palettes used to build a composite picture will then reappear. Full Screen mode is useful when you 
want to focus solely on the features in your composite picture and block out all other visual distractions. 

Line Art  
 

 
  
The Line Art button allows you to modify the style of your composite picture, making it look more like 
a drawing than a photograph. This feature is very useful, because it is sometimes inappropriate to use a 
composite picture that looks too much like a photograph. For instance, some states in the US prohibit the 
release of photo-like composite pictures to protect innocent people who might resemble the person 
portrayed in the picture. Since FACES composite pictures are almost photo-perfect in quality, the Line 
Art command can be used in these cases to modify the style of the completed picture. 

Enter BAC 
 

 
  
The Enter BAC button opens a dialog box in which you can enter a Biometric Alphanumeric Code. 
Once you have entered the BAC and closed the dialog box, the corresponding composite picture is 
automatically generated on your screen. This feature is extremely useful when you want to send your 
FACES composite picture to another FACES user, or generate the pictures of BACs you have seen in 
the newspaper or on television. The FACES 4.0 EDU and FACES 4.0 EDU Plus programs do not 
support this function.  

ID Profile  
 

 
  
The ID Profile button displays an ID Profile dialog box that allows you to provide additional useful 
information on the person depicted in your composite picture (e.g., age, sex, address, clothing, etc.). 

Feature Codes  
 

 
  
The Feature Codes button displays the number, position and size of all of the facial features in your 
current composite picture. 
 

 11



Send Email  
 

 
 
The Send Email button allows you to send the composite file, and its BAC, as an attachment. 
 

5. Features Area  
 

 
 
The Features Area buttons allow you to select features whose corresponding sub-categories are 
displayed in the Selection Display. Each feature has a number of sub-categories associated with it, all of 
which are displayed on the pages in the Selection Display. For example, when you click on the Eyes 
button, a page with one or two eye sub-categories (e.g. narrow eyes, bulging eyes) is displayed in the 
Selection Display. You can browse through all of the eye sub-categories to find the exact eye shape you 
want for your composite picture. 
 

6. Selection Area  
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The Selection Area shows miniature images of the sub-categories of features selected in the Features 
Area (i.e. if you select Eyes in the Features Area, the Selection Display will show narrow eyes, bulging 
eyes, almond-shaped eyes etc.). You can browse through these pages using the navigation button at the 
bottom of the Selection Area. 

Sub-Categories Selection Menu 
 
 
  
 
 
 
 
 
 
 
 
The Sub-Categories Selection menu displays the thumbnails and names of selected feature sub-
categories (e.g. narrow eyes, bulging eyes, almond-shaped eyes etc.). Selected sub-category features are 
displayed in miniature image boxes (e.g. a display of narrow eyes) and their corresponding numbers are 
displayed in red in the upper left corner of each image box. This allows you to easily locate previously 
selected sub-categories. 

Previous/Next Page 
 

   
      
Use these icons to browse through the pages of feature sub-categories which are displayed in sequential 
order. Click the forward arrow to move to the following page or the back arrow to return to the previous 
page. 
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First/Last Page 
 

   
      
Use these icons to go directly to the first or last page of the Selection Display. 

Previous/Next Selected Item 
 

   
     
These icons allow you to browse through all previously selected feature numbers. Each time a feature 
from the Selection Display is added to a portrait, its corresponding number is displayed in green in the 
upper left corner of the image box, indicating that it has been selected. A cumulative list of selected 
feature numbers (called the Features List) is generated during each work session, making it easy for you 
to return to previously selected features and choose the most appropriate one for your composite picture.  
 

7. Control Area  
  

 

Delete Current Feature 
 

 
  
The Delete Current Feature button deletes a selected feature from your composite picture. 

Move Up / Move Down and Position Slider 
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The Position Slider allows you to adjust the position of the different features in your composite picture. 
To use the slider, select the feature you wish to move, and click on the slider. Keeping the mouse button 
depressed, drag the slider up or down to move the selected feature to the desired position. 
 
The Move Up and Move Down buttons allow you to position the features of your composite picture 
millimeter by millimeter. For example, when you selected a nose and click on the Move Down button, 
you move the nose in your picture down by 1 millimeter. 

Move Further / Move Closer 
 

 
      
The Move Further and Move Closer buttons allow you to adjust the distance between the eyes. Move 
Further will increase the gap between the eyes while Move Closer will bring the eyes closer together. 
The eyebrows and the eye lines automatically align themselves with the position of the eyes. 

Reduce / Enlarge 
 

      
 
The Reduce / Enlarge buttons allow you to adjust the size of certain features (e.g., noses, lips, hair, 
mustaches, beards, eyebrows, moles and scars). For example, this button is useful if you need to fit a 
beard to a narrow chin. 

Hair Flip 
 

 
 
The Hair Flip button allows a hair style to be reversed from side to side. 

Hair Tone      
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The Hair Tone slider control allows you to change the tone of hair elements. You can use the hair tone 
option in hair, eyebrows, mustaches, goatees and beards. 
 

Positioning Control 
 

 
 
The Positioning Control allows you to move features like moles, tattoos, scars and piercings up, down, 
left or right. 
 

8. BAC Area  
 

 
 
The BAC (Biometric Alphanumeric Code) is a special feature of FACES which allows each composite 
picture to be encrypted into an ID code. Just as every new composite picture is an original creation, 
every BAC is entirely unique, much like a fingerprint. The BAC allows you to automatically generate a 
composite developed by someone else on your screen. All you have to do is type the composite’s BAC 
in your Enter BAC dialog box. Thus, it takes nothing more than a phone call or email for one FACES 
user to transmit a composite picture to another FACES user, since the only information exchanged is the 
BAC. By effectively bypassing the often cumbersome process of transmitting graphic data, this 
breakthrough feature of FACES makes it possible to send perfect quality images in a matter of seconds. 
The FACES 4.0 EDU and FACES 4.0 EDU Plus programs do not support this function.  
 
 

9. Slide Show Area  
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The Slide Show Area allows you to preview all composites created during a particular session. This 
feature allows you to preview the composites one by one until you stop the slide show.  

Run Slide Show 
 

 
 
The Run Slide Show command allows you to run the slide show. 

Stop Slide Show 
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The Stop Slide Show command allows you to stop the slide show. 

Pause Slide Show 
 

 
 
The Pause Slide Show command allows you to pause the slide show. The composite will be highlighted 
until you run the slide show command again. 

Show Next Slide 
 

 
 
The Show Next Slide command allows you to advance the slide show to the next composite in the Slide 
Show Area. 

Show Previous Slide 
 

 
 
The Show Previous Slide command allows you to view the previous composite in the Slide Show Area. 

Accelerate Slide Show 
 

 
 
The Accelerate Slide Show command allows you to increase the speed in which the composites are 
changed from one to another. 

Decelerate Slide Show 
 

 
 
The Decelerate Slide Show command allows you to reduce the speed in which the composites are 
changed from one to another. 

Add to Slide Show 
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The Add to Slide Show command allows you to add the current composite to the Slide Show Preview 
Area. You must make changes to your composite in order to enable this option.  

Move Toward End 
 

 
 
The Move Toward End command allows you to advance the slide show to the last composite in the Slide 
Show Area. 

Move Toward Beginning 
 

 
 
The Move Toward Beginning command allows you to go back to the first composite in the Slide Show 
Area. 

Clear Slide Show 
 

 
 
The Clear Slide Show command allows you to clear all composites from the slide show. You will not be 
able to retrieve these composites unless you have them saved before running this command. 

Remove Frame from Slide Show 
 

 
 
The Remove Frame from Slide Show command allows you to remove the highlighted frame from the 
Slide Show Area. 
 

Menu Bar Commands  
 
The Menu Bar is the horizontal bar located in the upper portion of your screen that contains all of the 
FACES commands: 
 

 File Menu Commands 
 

 Edit Menu Commands 
 

 View Menu Commands 
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 Exercise Menu Commands 
 

 Features Menu Commands 
 

 Select Menu Commands 
 

 Control Menu Commands 
 

 Language Menu Commands 
 

 Help Menu Commands (Windows) 
 

File Menu Commands 
 
New 
Use this command to create a new composite picture in FACES. 
If you select this command while you are working on a composite picture, a dialog box will appear 
asking if you wish to save your current work as a project. If you answer “Yes”, the Save As dialog box 
will appear, asking you to give a file name and location. If you answer “No”, the facial features will 
disappear from your screen, leaving you with a blank template.  
Keys:  CTRL+N   Command+N 
 
Open 
Use this command to open an existing composite picture in FACES. 
If you select this command while you are working on a composite picture, a dialog box will appear 
asking if you wish to save your current work as a project. If you answer “Yes”, the Save As dialog box 
will appear asking you to give a file name and location. If you answer “No”, the Open dialog box will 
appear.  
Keys:  CTRL+O   Command+O 
 
Save 
Use this command to save an open document to its current file name and directory. 
When you save a picture for the first time, FACES displays the Save As dialog box which allows you to 
enter a name for your picture. Once you have saved a composite picture to a specified file name and 
directory, you can use the Save command to save your document to the same name and directory. 
If you wish to change the name and directory of an existing picture before saving it, use the Save As 
command (see below). 
Keys:  CTRL+S   Command+S 
 
Save As 
Use this command to save your current composite picture to a specified file name and directory. To save 
your picture to its original name and directory, use the Save command. 
 
Send Email 
Use this command if you wish to send a composite, and its BAC, by email. 
 
Export 

 20



Use this command to save the image of your current composite picture in an image file which may be 
imported into a word processing or image-editing application. FACES displays the Save As dialog box 
for you to assign a name to your image file. 
The standard image file format for Windows is JPEG. 
 
Page Setup 
Use this command to select a printer and printer connection. A Print Setup dialog box appears, allowing 
you to specify the printer and its connection. 
 
Print Portrait 
Use this command to print a composite picture. A Print dialog box will appear in which you may specify 
the number of copies you wish to print, the destination printer and other printer setup options. 
Keys:  CTRL+P   Command-P 
 
Print ID Profile 
Use this command to print the ID Profile corresponding to your current composite picture. A Print 
dialog box will appear in which you may specify the number of copies you wish to print, the destination 
printer and other printer setup options. 
 
Exit 
Use this command to end your FACES session. FACES will ask you to save any composite pictures you 
have modified without saving the changes. 
Keys:  ALT+F4   Command-Q 

Edit Menu Commands 
 
The Edit menu offers the following commands: 
 
Cut 
Use this command to cut text from any edit boxes, including edit boxes in the dialog boxes and the BAC 
window in the top right corner of your FACES window. 
Keys:  CTRL+X   Command-X 
 
 
Copy 
Use this command to copy text from any edit boxes, including edit boxes in the dialog boxes and the 
BAC window in the top right corner of your FACES window.  
Keys:  CTRL+C   Command-C 
 
Paste 
Use this command to paste text into any edit boxes, including edit boxes in the dialog boxes and the 
BAC window in the top right corner of your FACES window.  
Note: You can enter a new BAC by selecting the Enter BAC command, or clicking on the Feature Codes 
/ Enter BAC button, and then pasting the new BAC into the edit box. 
Keys:  CTRL+V   Command-V 
 
Delete 
Use this command to delete text in any edit boxes, including edit boxes in the dialog boxes and the BAC 
window in the top right corner of your FACES window.  
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Keys:  Del   Backspace 
 
Edit Autorun Demo 
Use this command to open the Edit Autorun Demo dialog box which allows you to modify the sequence 
of features in your Autorun definition file by adding, deleting or replacing features in their 
corresponding line numbers. 
 
Feature Codes 
Use this command to open a dialog box in which you can enter a new BAC or preview the feature codes 
that you are currently using. Once you have entered your BAC, close the dialog box, and the 
corresponding composite picture will be automatically generated in the Viewer Area window. The 
FACES 4.0 EDU and FACES 4.0 EDU Plus programs will not allow you to enter a BAC.  
 
 
ID Profile 
Use this command to open the ID Profile dialog box which contains important information about the 
person portrayed in the composite picture (e.g., age, sex, address, occupation, clothing, etc.) to assist 
with identification.  
Keys:  CTRL+I   Command-I 

View Menu Commands 
 
The View menu offers the following commands: 
 
Full Screen 
Displays a full screen preview of your composite picture. 
In Full Screen mode, your composite picture is displayed alone on a white background. You can revert 
to normal screen mode by clicking again on the Full Screen command. All of the buttons and palettes 
used to build a composite picture will then reappear. Full Screen mode is useful when you want to focus 
solely on the features in your composite picture and block out all other visual distractions. 
Keys:  CTRL+F   Command+F 
 
Line Art Mode 
This command allows you to modify the style of your composite picture, making it look more like a 
drawing than a photograph. This feature is very useful, because it is sometimes inappropriate to use a 
composite picture that looks too much like a photograph. For instance, some states in the US prohibit the 
release of photo-like composite pictures to protect innocent people who might resemble the person 
portrayed in the picture. Since FACES composite pictures are almost photo-perfect in quality, the Line 
Art button can be used in these cases to modify the style of the picture. 
Keys:   CTRL+L   Command+L 
 
Hide/Show Portrait 
Use this command to turn your FACES Portrait Area on or off. This command allows you to keep your 
work confidential. When selected, it will hide your composite picture, displaying only the Portrait Area 
background. This option is useful if you have to leave your desk temporarily while working on a portrait 
that you don’t want anyone else to see. 
 
Hide Catalog 
Use this command to turn your FACES Catalog Area on or off.   
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Observation Exercise Menu Commands 
 
Start Observation Exercise / Stop Observation Exercise 
Use this command to start or stop an Observation Game. 
The Observation Game allows you to develop your observation skills. A composite picture generated by 
FACES is displayed for a few seconds. During this time, you should examine the picture closely and try 
to remember as many of the facial characteristics as possible in order to reproduce them afterwards. 
 
Before the Observation Exercise begins, a dialog box is displayed in which you can select a level of 
difficulty. These levels are determined either by the number of feature sub-categories available in each 
feature category, or by the duration of the display period. For example, the beginners’ level (Level 1) 
offers fewer available features, making your choices easier, and a longer display period. Once you have 
selected a level, the Observation Exercise begins. You can stop the Observation Exercise by re-selecting 
the Start Observation Exercise / Stop Observation Exercise command. 
Keys:  CTRL+G   Command+G 
 
Review Observation Exercise Portrait 
Displays the Observation Exercise Portrait in the Selection Display window. 
The Observation Exercise Portrait disappears from the Viewer Area after the specified time period, 
giving you time to reproduce it as accurately as possible. Once you are satisfied with your reproduction, 
you can re-display the Observation Exercise Portrait by selecting the Show Observation Exercise 
Portrait command. The Observation Exercise Portrait will be displayed in the Selection Display, 
allowing you to compare your reproduction with the original. As soon as you click on any feature button 
in the Features Palette, the Observation Exercise Portrait disappears and the feature image boxes 
reappear in the Selection Display. 
 
Random Faces 
This command displays a composite picture that is generated through a random selection of facial 
features. Not only does it give inexperienced users an idea of how a face is created, it also familiarizes 
them with different types of facial features and characteristics. 
 
Start Autorun Demo 
Use this command to launch a FACES demonstration. 
The Autorun Demo is a default sequence of composite pictures that change approximately every second. 
You can modify the default sequence to create your own personalized sequence by selecting the Edit 
Autorun Demo command. 
Keys:   CTRL+D   Command-D 

Features Menu Commands 
 
The Features menu commands allow you to select different features (e.g. eyes, nose, lips, etc.) for your 
composite picture. The first page of several pages of sub-categories corresponding to your selected 
feature (e.g. narrow eyes, almond-shaped eyes etc.) will appear in the Selection Display. Once feature 
sub-categories are displayed in the Selection Display, they may be selected and added to the composite 
picture. 
 
All of the commands in this menu select and load the sub-categories corresponding to the feature 
selected. The Features menu contains the following commands: 
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 Hair 
 Head Shapes 
 Eyebrows 
 Eyes 
 Noses 
 Lips 
 Jaw Shapes 
 Mustaches 
 Beards 
 Goatees 
 Skin Tones 
 Forehead Lines 
 Eye Lines 
 Smile Lines 
 Mouth Lines 
 Chin Lines 
 Headwear 
 Glasses 
 Moles 
 Scars 
 Piercings 
 Tattoos 

Select Menu Commands 
 
The Select menu contains commands that allow you to browse through the sub-category pages in the 
Selection Display. 
 
Previous Page 
Use this command to go to the previous page of feature sub-categories. 
 
Next Page 
Use this command to go to the next page of feature sub-categories. 
 
First Page 
Use this command to go to the first page of feature sub-categories. 
 
Last Page 
Use this command to go to the last page of feature sub-categories. 
 
Previous Selection 
Use this command to browse backwards through all previously selected feature numbers.   
Each time you add a new feature from the Selection Display to your composite picture, its 
corresponding feature number is added to the Features List. You can browse through this list at any time 
to compare different feature sub-categories and select the one that is most appropriate for your picture. 
 
Next Selection 
Use this command to browse forward through all previously selected feature numbers. 
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Each time you add a new feature from the Selection Display to your composite picture, its 
corresponding feature number is added to the Features List. You can browse through this list at any time 
to compare different feature sub-categories and select the one that is most appropriate for your picture. 

Control Menu Commands 
 
Delete Selected Feature 
Use this command to delete a selected feature in your composite picture. 
 
Move Feature Up 
Use this command to move a selected feature in your composite picture up by one millimeter. 
 
Move Feature Down 
Use this command to move a selected feature in your composite picture down by one millimeter. 
 
Move Further Apart 
The Move Further Apart command allows you to increase the distance between the eyes in your 
composite picture. The eyebrows and eye lines will automatically align themselves with the new 
position of the eyes. 
 
Move Closer Together 
The Move Closer Together command allows you to bring the eyes in your composite picture closer 
together. The eyebrows and the eye lines will automatically align themselves with the new position of 
the eyes. 
 
Reduce Size 
The Reduce Size command allows you to reduce the size of certain features (e.g., noses, lips, hair, 
mustaches and beards). This is useful if you need to fit a beard to a narrow chin, for example. 
 
Enlarge Size 
The Enlarge Size command allows you to enlarge the size of certain features (e.g., noses, lips, hair, 
mustaches and beards). This is useful if you need to fit a beard to a wide chin, for example. 
 
Flip 
The Flip command allows you to flip hair styles from side to side. 
 
Darken 
The Darken command allows you to darken hair elements such as hair, eyebrows, mustaches, goatees 
and beards. 
 
Lighten 
The Lighten command allows you to lighten hair elements such as hair, eyebrows, mustaches, goatees 
and beards. 
 
Move Up 
The Move Up command allows you to move up features such as moles, piercings, tattoos and scars. 
 
Move Left 
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The Move Left command allows you to move to the left features such as moles, piercings, tattoos and 
scars. 
 
Move Right 
The Move Right command allows you to move to the right features such as moles, piercings, tattoos and 
scars. 
 
Move Down 
The Move Down command allows you to move down features such as moles, piercings, tattoos and 
scars. 
 

Language Menu Commands  
 
The Language menu commands allow you to switch between English, French and Spanish versions of 
FACES. 

Help Menu Commands  
 
The Help menu offers the following commands to assist you in the use of your FACES application: 
 
Help 
Use this command to display the opening screen of Help, which offers you information on how to access 
the user’s guide. 
 
About FACES 
This command displays the copyright notice and version number of your FACES application, as well as 
user license information, endorsements and a list of safety tips for parents and children.  
 

Dialog Boxes  

Edit Autorun Demo Dialog Box 
 
FACES comes with an Autorun Demo feature which consists of a sequence of continuously changing 
composite pictures designed to demonstrate the capabilities of your application. 
 
By using the Edit Autorun command, you can edit your default Autorun file and create a personalized 
sequence of changing composite pictures. 
 
A good way to build your own Autorun file is to first create a series of composite pictures, noting down 
the number, position and size of each feature displayed in the Feature Codes dialog box. You can then 
use these notes to modify the features in your Autorun sequence. 
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When you open the Edit Autorun dialog box, you will be presented with a list of all the feature numbers 
included in the default sequence. You have the option of modifying, inserting or deleting one or several 
of the features that appear in this list. In order to make modifications, you must first select a line in the 
sequence by clicking on it. Once a line is selected, its contents will be displayed in the edit boxes in the 
upper portion of the dialog box. The following is a list of the different fields and their functions: 
 
Line Number 
This field displays the currently selected line in the sequence and cannot be edited. 
 
Hide / Show 
These radio buttons are used to specify whether you want to show a particular feature in your sequence 
or hide a previously displayed feature. Suppose, for example, that you have a beard in your sequence 
and want to morph the portrait into a woman. You need to remove the beard from the sequence, which 
you can do by clicking on Hide and selecting Beard in the Features pull-down menu. 
 
Features 
This is a list of all the features you can use to create a composite picture. Simply click in the edit box 
and select one of the features in the menu. 
 
Feature Number 
This is a list of all of the feature numbers corresponding to the available features. Simply click in the 
edit box and select one of the numbers in the menu. You may also enter the number manually. If the 
number you enter is not available, it will not be accepted and the edit box will display a blank field. 
 
Position 
This is a list of available positions for the feature you have selected. Simply click in the edit box and 
select one of the positions in the menu. You may enter the position manually. If the number you enter 
exceeds the limit, it will be truncated to the next valid position number. 
 
Size 
This is a list of available sizes for the feature you have selected. Not all the features have the same 
available sizes. If the size you want is available, simply click in the edit box and select the size in the 
menu. You may also enter the size manually. If the number you enter exceeds the limit, it will be 
truncated to the next valid size number. 
 
Remove Line 
This button removes the currently selected line from the Autorun sequence. 
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Modify Line 
This button will replace the currently selected line with the content of the edit boxes. 
 
Insert Line 
This button will push down the currently selected line and all of the following lines by one line. The 
content of the edit boxes will then be written into the newly inserted line. If you need to add a new line 
at the end of the sequence, simply select the blank line immediately following the last one, select your 
content, and click the Insert Line button. 
 
Clear All 
This button removes all lines from the Autorun sequence. 
 
Default 
This button restores the default Autorun sequence. 

ID Profile Dialog Box 
 

 
 
The ID Profile dialog box allows you to enter additional information about the person portrayed in your 
composite picture that may assist with identification. There are three types of interactive items in the ID 
Profile dialog box: edit boxes, pull-down menus and link buttons. 
 
Edit boxes 
Edit boxes allow you to type in whatever information you want. 
 
Pull-down menus 
Pull-down menus look like edit boxes with a downward-pointing arrow at the end. They allow you to 
either select items from a list or type in your own information.  
 
Link buttons 
Apart from the OK and Cancel buttons, all the link buttons open other dialog boxes that allow you to 
enter even more information on a person.  
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Body Parts Dialog Box 
 

 
 
The Body Parts dialog box shows a frontal and rear view of a man or woman, depending on whether you 
specified the sex as man or woman in the ID Profile dialog box. You can click directly on different body 
parts to select the corresponding descriptions instead of selecting them from the pull-down menu. This is 
useful if you don’t know the name of a particular body part, but can show exactly where it is located. 

Start Observation Exercise Dialog Box  
 

 
 
The Start Observation Exercise dialog box allows you to select one of five difficulty levels for the 
Observation Exercise. When you select a level, you will be shown a number of possible features, of 
which one in each category was used to generate the Observation Exercise Portrait. When you are 
recreating the Observation Exercise Portrait, you will have to choose among these possible features. 
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You may also modify the Observation Exercise Portrait display time (i.e., the number of seconds you are 
given to examine the Observation Exercise Portrait before starting your reconstruction of it). 
 
Press the Start Exercise button to start the game. 
 

How To...    

How to Create a New Composite Picture 
 

 
 
To create a new composite picture, all you have to do is open a new template by using the New 
command in the File menu, or clicking on the New button on the toolbar. 

How to Open a Composite Picture 
 

 
 
To open an existing composite picture, click on the Open command in the File menu, or click on the 
Open button on the toolbar, and select the file containing the composite picture of your choice using the 
File Open dialog box. 
 

How to Save a Composite Picture 
 

 
 
To save an existing composite picture, click on the Save command in the File menu or click on the Save 
button on the toolbar. If you are saving an existing composite picture, it will automatically be saved in 
an existing file. If, however, you are saving a new composite picture, you must specify a file name and 
location in the Save As dialog box that will appear. 
 
To save an existing composite picture in a different file, click on the Save As command in the File menu 
and specify, in the Save As dialog box, the name and location of the new file in which you want to save 
the composite picture. 
 
There is no button on the toolbar to execute this command. 

How to Print a Composite Picture 
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To print a composite picture, click on the Print Portrait command in the File menu, or click on the Print 
button on the toolbar. This will print the current composite picture. You may specify the number of 
copies you wish to print in the Page Setup dialog box that appears. 
 
You can also print an ID Profile by selecting the Print ID Profile command in the File menu. This will 
print a small version of the composite picture along with all the information entered in the ID Profile 
dialog box. 
 
There is no button on the toolbar to execute this command. 

How to Play an Observation Game  
 
FACES provides an Observation Game that allows you to develop your observation skills. A composite 
picture generated by FACES (called the Observation Exercise Portrait) is displayed for a few seconds. 
During this time, you should examine the picture closely and try to remember as many of the facial 
characteristics as possible in order to accurately reproduce them afterwards. An Observation Exercise is 
played in three stages: 
 
1.  Display of Observation Exercise 
 

 
 
To display a composite picture generated by FACES, click on the Play button on the toolbar. Before the 
Observation Exercise begins, a dialog box is displayed in which you can select a level of difficulty. 
These levels are determined either by the number of feature sub-categories available in each feature 
category, or by the duration of the display period. For example, the beginners’ level (Level 1) offers 
fewer available features, making your choices easier, and a longer display period. Once you have 
selected a level, the Observation Exercise begins. An Observation Exercise Portrait will appear for a few 
seconds and will then disappear. 
 

 31



Since composite pictures generated by FACES are made up of randomly selected facial features, some 
Observation Exercise Portraits might look odd or unrealistic. If you would like to cancel the Observation 
Exercise displayed, click on the Stop Observation Exercise button. 
 
2.  Recreation of Observation Exercise Portrait Using the Features Palette 
Try to recreate the Observation Exercise Portrait in a new viewer using the Features Palette. 
As you are working on your reproduction, you may view the Observation Exercise Portrait again by 
clicking on the Review Observation Exercise Portrait button. The Observation Exercise Portrait will be 
displayed in the Selection Area. To remove the Observation Exercise Portrait, click on a feature in the 
Features Palette and the Selection Display will return. 
 
3. Comparison of Your Reproduction with the Original 
 

 
 
Once you are satisfied with your reproduction, click on the Stop Observation Exercise button to open the 
Observation Exercise Results dialog box which will display your reproduction next to the original 
Observation Exercise Portrait. By comparing the two composite pictures, you can discover details you 
might have overlooked, and improve your observation skills. 

How to Change the Observation Exercise Difficulty Level 
 
To change the difficulty level of the Observation Exercise, you must first click on the Start Observation 
Exercise button on the tool bar.  
 
A dialog box will appear in which you can select a new difficulty level. You may also change the 
duration of the Observation Exercise Portrait display. 

How to Select a Composite Picture Feature 
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To select a composite picture feature, click on the button corresponding to the feature you want (e.g. 
eyes) in the Features Palette located in the Selection Area. The first of several pages of sub-categories 
corresponding to the feature you selected will appear in the Selection Display (e.g. narrow eyes). To 
select a feature within a sub-category, click on the arrow next to the category icon. To view other feature 
numbers corresponding to your selected feature, use the navigation buttons located below the Selection 
Area. 
 
You can highlight a feature sub-category by selecting its description using the arrow next to the category 
icon. The numbers of the features contained in this sub-category will be displayed in red. 

How to Add or Change a Composite Picture Feature 
 

 
 
To add or change a composite picture feature, select a new feature from one of the sub-categories in the 
Selection Display. This new feature will immediately appear in your composite picture, and will replace 
the corresponding feature you had previously selected. 
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How to Delete a Composite Picture Feature 
 

 
 
To delete a composite picture feature, select the feature in the Selection Display and click on the Delete 
button located below the Features Palette buttons. 

How to Position a Composite Picture Feature 
 
       

 

 

 

 

Positioning Mechanisms 
 
To modify the position of a composite picture feature, you need to select the feature you want to move 
in the Features Palette. You can then move the feature using the Position Slider, or one of the Move 
buttons located just above and below the Position Slider. The Slider allows you to visually control the 
position of the feature, while the Move buttons allow you to position the feature with greater accuracy. 
 
Unlike the other features, the eyes cannot be moved vertically, since they are a fixed reference point for 
building a composite picture. However, you can move the eyes closer together or further apart by 
clicking on the Move Closer or Move Apart buttons. These two buttons automatically replace the 
Position Slider when you select the eyes. 

How to Erase the Contents of a Composite Picture 
 

 
 
You can erase the contents of a composite picture by starting a new composite picture. To start a new 
composite picture, simply click on the New button on the toolbar. You will be presented with an empty 
viewer window. 
 

Tutorial  
 
In this section, we will show you step-by-step how to create a composite picture. If you haven’t already 
done so, open your FACES application by double-clicking on the FACES icon. 
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Step 1: Entering the Basic Features of Your Composite Picture 
Step 2: Modifying Your Composite Picture 
Step 3: Saving Your Composite Picture in a File 

Step 1: Entering the Basic Features of Your Composite Picture 
 
If you already have an empty viewer, you can skip the following instructions. To create a new viewer, 
click on the New button on the toolbar showing an empty page with one corner turned over (the first 
icon), or click on the New command in the File menu. 
 
It is recommended to start your picture with the eyes, since they are generally the most striking feature 
of a face. Even if the eyes you choose are not exactly those of the picture you are trying to recreate, you 
can always select a different pair later on. The same is true for all of the other composite picture 
features. 
 
- Click on the Eyes button in the Features Palette. Using the Next Page button below the Selection Area, 
browse until you find Eyes No. 409 and click on them. 
 
- Click on the Nose button and select the sub-category Hooked, Nostrils Not Showing in the sub-
categories pull-down menu. Click on Nose No. 601. 
 
- Click on the Mouth button and, using the Next Page button, find Mouth No. 214 and click on it. 
 
- Browse through the Chins and click on Chin No. 316. 
 
- Click on Head No. 103. 
 
- Browse through Eyebrows in the Thick sub-category and click on Eyebrows No. 806. 
 
- Click on Hair No. 105. 
 
- Finally, click on Forehead Lines No. 102. 
 
Congratulations! You now have a composite picture base which you can continue to modify.  

Step 2:  Modifying Your Composite Picture 
 
When you examine your composite picture closely, you may notice that the mouth is a bit too narrow, 
the eyes too far apart, the eyebrows too low, the eye lines too high and the hair is too big for the shape of 
the head. You need to make some changes. 
 
First, click on the Mouth button and click on Mouth No. 216. You will see that the new mouth replaces 
the mouth you had originally chosen. This is exactly what you wanted. 
 
Second, click on the Eyes button. Notice that the Move Further and Move Closer buttons have replaced 
the Slider. Click twice on the Move Closer button to narrow the space between the eyes.  
 
Now click on the Eyebrows button. Click on the Position Slider located below the Features Palette 
buttons and raise it until the eyebrows reach the correct height. 
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Click on the Forehead Lines button. You could, as in the case of the eyebrows, lower the forehead lines 
using the Position Slider. You can also try an alternative method. Click three times on the Move Down 
button below the Position Slider. You have successfully lowered the forehead lines by three millimeters. 
 
Now, click on the Hair button. Click three times on the Reduce button located at the bottom of the 
FACES window under the Position Slider. 

Step 3:  Saving Your Composite Picture in a File 
 
The final step is to save your work in a file so that you can retrieve it at a later date. Click on the Save 
button, or select the Save command in the File menu. In the dialog box that appears, select the file in 
which you want to save your composite picture and enter the file name. Click on the OK button, and 
your composite is saved. 
 
The next time you want to see this composite picture, all you have to do is click on the Open button, or 
select Open in the File menu.  Find the file name you saved the picture under, and select it.  You can 
then modify the picture and save it again in the same file, or you can save it in a new file in order to 
keep both the original and new versions. 
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